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摘   要 
   目前常用的 S7－300CPU 主要有： 

新型 CPU：使用 MMC 卡作为装载存储器,不需要后备锂电池，免维护。 

    标准 CPU：也称为老式的 S7-300 CPU,使用 FEPROM 卡作为装载存储器，需要后备电池维         

持系统时钟。除了 S7-318 2DP 外，其它的老式 PLC 已不再出售。 

由于存储介质的不同，对于存储卡的使用及对用户程序的数据保存有所不同， 

   本文档主要用于解决以下问题： 

 了解 S7－300CPU 存储器的概念及区域划分 

 了解新型 S7－300CPU 及标准型 S7－300CPU 的区别 

 MMC 卡的使用方法及注意事项，包括如何将程序写入和删除等 

 FEPROM 卡的使用方法及注意事项，包括如何将程序写入及删除等 

 了解用户程序在 S7－300CPU 的数据保持问题，包括如何定义保持区等 

 S7－300CPU 的启动方式及如何进行存储器复位 

 如何将存储卡格式化 

 

关键词 

    新型 CPU；标准 CPU；存储器；微型存储器；保持存储器；闪存；暖启动； 

保持存储区 

 

 Key Words 

New CPU； Standard Cpu；Memory；MMC；Flash Eprom；Warm start；Retentive Memory 
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1. S7 300 存储区概述 

S7-300 PLC 的存储区可以划分为四个区域：装载存储器(Load Memory)、工作存储器(Work 

Memory)、系统存储器（System Memory）和保持存储区（Non-Volatile memory），具体如图 7－1 

 

                                图 7－1 

S7-300 的存储器概念

注释

符号

块:
• 逻辑块

(OB,FC,FB)
• 数据块

(DB)

PG中的Flash 
EPROM 存储器卡
(随后插入CPU)
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• 逻辑块

(OB,FC,FB)
• 数据块

(DB)
附加信息

系统存储器:
• PII, PIQ
• M, T, C

• 保持的
M, T, C

• 保持的数据块

保持存储器:

当系统断
电时，不
用电池做
后备

n. reten.    reten.

当系统有
电时，不
用电池做
后备

RAM

块：
• 逻辑块

(OB,FC,FB)
• 数据块

(DB)
附加信息

装载存储器：

Flash-
EPROM

工作存储器:
• OB,FC,FB
• DB

n. reten.     reten.

4

3

2 

1

1. 系统存储器： 

系统存储器用于存放输入输出过程映像区（PII,PIQ）、位存储器(M)、定时器(T)和计数

器(C))、块堆栈和中断堆栈以及临时存储器(本地数据堆栈)。 

2. 工作存储器： 

工作存储器仅包含运行时使用的程序和数据。RAM 工作存储器集成在 CPU 中， RAM 中

的内容通过电源模块供电或后备电池保持。除了 S7 417-4 CPU 可以通过插入专用的存储卡来

扩展工作存储器外，其他 PLC 的工作存储器都无法扩展。 

3. 装载存储器： 

装载存储器是用于存放不包含符号地址分配或注释(这些保留在编程设备的存储器中)的

用户程序。装载存储器可以是存储器卡、内部集成的 RAM 或内部集成的 EPROM. 

4. 保持存储器： 

保持存储器是非易失性的 RAM，通过组态可以在 PLC 掉电后即使没有安装后备电池的情

况下，保存一部分位存储器（M）、定时器(T)、计数器（C）和数据块(DB)。在设置 CPU 参
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数时一定要指定要保持的区域。（注意：由于 S7-400 PLC 没有非易失性 RAM，即使组态了

保持区域，再掉电时若没有后备电池，也将丢失所有数据。这是 S7-300 PLC 与 S7-400 PLC 的

重要区别）                                

1) 当在 step7 中执行下装（download）时，会把编程设备中的用户程序下装到 CPU 的装

载存储区，同时会把运行时使用的程序和数据写入工作存储区(如 OB1 和数据块)。 

2) 若 CPU 没有后备电池，当系统断电时，在工作存储器中定义了保持特性的数据块会把

数据写入保持存储器中，上电后保持存储器会把断电时的数据写入到工作存储区， 保

证了运行数据断电不丢失（过程如图 7－1 中    与     箭头所示）。 

3) 若 CPU 没有后备电池，当系统断电时，系统存储区中定义的保持位存储器(M)、定时器

(T)和计数器(C))断电时也会写入保持存储器，恢复上电时断电时的数据重新写入，保证

了运行数据断电不丢失（如图 7－1 中    与    箭头所示）。    

2. S7-300 CPU 的分类 

      按照 CPU 的装载存储器来分类：新型 S7-300 CPU、标准型 S7-300 CPU、带内置 EPROM 的

S7300 CPU，具体描述如下： 

2.1. 新型 S7-300 CPU 

  新型 S7-300 CPU 是指使用 MMC 卡作为其装载存储器的 CPU,此类 CPU 不用安装后备电池,免

维护。由于新型 S7300-CPU 它不含内置的装载存储器，因此必须使用 MMC 卡。新型的 S7-300 CPU

包括紧凑型 (即 CPU31xC 系列)和由标准型更新的新型 CPU。任何程序的下载方式都直接保存到卡

中， 没有 MMC 卡，是无法把程序下载到 CPU 中的。 

注意：在西门子的 CPU 上必须使用西门子专用的 MMC 卡，不能使用数码相机、移动电话或 PDA

等数码产品使用的通用型 MMC 卡。目前应用于以下几种 PLC 产品： 

订货号    产品名称 

6ES7 314-1AF**-0AB0  新型 CPU 314 

6ES7 315-2AG**-0AB0  新型 CPU 315-2DP 

6ES7 312-5BD**-0AB0  CPU 312C 

6ES7 313-5BE**-0AB0  CPU 313C 

6ES7 313-6CE**-0AB0  CPU 313C-2DP 

6ES7 313-6BE**-0AB0  CPU 313C-2PTP 

6ES7 314-6CF**-0AB0  CPU 314C-2DP   

6ES7 314-6BF**-0AB0  CPU 314C-2PTP 
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6ES7 613-1CA**-0AE3  C7 613  

6ES7 635-2EC**-0AE3  C7 635 OP 

6ES7 635-2EB**-0AE3        C7 635 OP  

6ES7 151-7***-0AB0      ET200S with CPU             

注：以上产品的订货号会因为产品软硬件的升级略有调整，产品特性以产品名称为准。 

2.1.1. 用于新型 S7-300 CPU 的 MMC 卡 

MMC 卡是一种 FEPROM 卡，用于新型的 S7-300 CPU，包括紧凑型 CPU 和由标准型更新的新

型 CPU。新型 CPU 均没有内置的装载存储器，必须使用 MMC 卡作为其装载存储器保存用户数据。

CPU 掉电时，会自动将工作存储器中的数据拷贝到 MMC 中,保存 DB 块数据。如图 8-1 所示： 

MMC 卡需要用户根据程序大小单独订货，选型时建议大于 CPU 工作内存，CPU313，

CPU314,CPU315-2DP,CPU317-2DP 系列CPU的可插拔MMC卡最大支持8 MB ，其他最高支持4 MB 

用于新型 S7-300 CPU 的 MMC 卡(Micro Memory Card )型号如下： 

             64 KB   6ES7 953-8LF11-0AA0 

128 KB  6ES7 953-8LG11-0AA0 

512 KB  6ES7 953-8LJ11-0AA0 

2 MB    6ES7 953-8LL11-0AA0 

4 MB    6ES7 953-8LM11-0AA0 

8 MB    6ES7 953-8LP11-0AA0 

注：以上产品的订货号会因为产品软硬件的升级略有调整，产品特性以产品名称为准。 

 

                             图 8－1 

编程器                     MMC                 CPU31xC 

                      
 保存在硬盘中              装载存储器             工作存储器 
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2.1.2. MMC 卡使用寿命 

MMC的使用寿命主要取决于以下因素： 

1.  删除或编程步骤的数量。 

使用MMC的CPU有SFC 82，83，84等特性，可以进行数据的读写： 

 SFC82“CREA_DBL”：在装载内存（Load Memory）中生成数据块  

 SFC83“READ_DBL”：读装载内存（Load Memory）中的数据块 

 SFC84“WRIT_DBL”：写数据块（内容）到装载内存（Load Memory）即MMC卡中。 

    但是，请注意由于MMC卡重复写入的次数是有限的，所以当调用SFC 84向MMC卡写数据

时最好只在相应的时间间隔(例如每小时，每天...)调用。如果MMC卡在保存时发生故障，相关

的调用块会发出否定应答，其结果存放在程序的返回值（RET_VAL）中。错误就会记录在CPU

的诊断缓冲区中。 

    关于SFC 82，83，84 的使用参见文档“MMC卡数据的读写”。 

文档链接：http://www.ad.siemens.com.cn/service/e-training/detail.asp?attachmentid=183。 

                           

2. 外界影响，例如周围温度。 

     当周围温度超过为60℃时，会影响MMC的使用寿命，0-60℃的工作环境下，MMC卡可进行删除/ 写    

操作100,000次 

3. MMC 卡严禁带电插拔。务必在电源关闭的条件下拆卸该卡。带电插拔时会使卡烧坏。    

4. 一些意外情况情况也会损坏 MMC 卡 

1） 当装载用户程序时突然断电 

2） 当执行 “copy  RAM to ROM”时突然断电。 

3） 当存储器复位时出现模块存储赋值错误。 

4） 错误格式化或格式化不能进行。 

5） 当用户用手触摸 MMC 卡金属部分时，如果有静电，也可能使卡损坏。     

注意：MMC 卡只能使用西门子的 PG 或西门子专有的读卡器（prommer）进行格式化，使用其

它第三方的读卡器进行读卡和格式化操作都将破坏此卡。 

 

2.1.3. 如何将程序写入 MMC 

MMC 是新型 CPU 的唯一的装载存储器，任何程序的下载方式都直接保存到卡中。 
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下载的方法有如下几种： 

1． 直接下载：用快捷栏中的下载按键  直接下载。或使用 STEP7 中的“PLC >“Download”

菜单命令下载。（如图 8－2） 

                  

                                        图 8－2 

2． 使用 STEP7 中的“PLC >“Download User Program to Memory Card”菜单命令将整个程序下

载（如图 8－2），注意使用该指令时不能下载单个或部分程序块，只能整体下载，同时会将

MMC 卡中原来的内容清除。此方法也同样适用于 FEPROM 卡。 

3． 使用 STEP7 中的“PLC >Copy RAM to ROM” （如图 8－2） 菜单命令，可以把工作存储

器的内容拷贝到 MMC 卡中，同时会将 MMC 卡中原来的内容清除。此操作只能是 CPU 在
STOP 模式下才能执行。这个指令用于把 CPU 中当前运行值 如 DB 块的运行值拷贝到

FEPROM 卡中，这样下次用 MRES 复位时，DB 块的值就会复位为保存过的值。此操作对于

FEPROM 卡同样有效，  
4． 使用 PG 时可以使用 STEP7 中的“File > S7-Memory Card > Open” 菜单命令（如图 8－3）

打开存储卡，再用“PLC > Save to Memory Card ”将文件写入 MMC.此方法也同样适用于

FEPROM 卡。 

              

                                       图 8－3 

5． 在程序中通过调用 SFC84“WRIT_DBL”（向装载存储器写数据块），可以将工作存储器中的

数据块（内容）写入装载存储器（存储卡）中。    
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2.1.4. 如何删除 MMC 卡中的程序 

 使用 MRES 或者“Clear/Reset”不能删除 MMC 卡中的数据，只能删除工作存储器中的内

容，并复位所有的 M,T,C 以及 DB 块的实际值。完成复位后会自动将 MMC 卡中的程序拷贝到

工作存储器中， 

如下方法可以删除 MMC 卡中的数据。 

1. 使用 STEP7 中的“View > Online” 菜单命令，在线打开 Blocks，选中要删除的块，用“Delete”

键，即可直接删除卡中的程序块。这点类似于 RAM 卡。 

2. 用“PLC >Download User Program to Memory Card” （如图 8－2）下载一个空的程序。 

3. 使用西门子编程器 PG 或西门子专用读卡器来删除或执行格式化。 

2.1.5. 删除 MMC 卡中的程序的特殊情况：被动格式化 

在下列情况出现时，有可能会要求进行被动格式化： 

1) 装入应用程序指令由于掉电而中断 

2) 向 MMC 卡写数据时由于掉电而中断 

3) 卡中程序的组态与实际的硬件配置不相符时 

4) 卡中有 CPU 无法正确识别的数据 

  可以执行被动格式化的标志为 CPU 的 STOP 灯出现慢闪，这是 CPU 在请求被动格式化，只

有此时可以用 MRES 按钮格式化 MMC 卡，把卡中的错误信息清除，具体操作方法如下： 

      将模式开关打到 MRES 并保持直到 STOP 灯保持常亮（约九秒），并在其后两秒内迅速开关，

使其返回到 STOP 再迅速按回到 MRES 位置，此时，STOP 灯快速闪烁，表示正在格式化。保持

开关在 MRES 位置，直到 STOP 灯常亮，格式化完成。 

注意：一定要使用规定的操作顺序。否则，MMC 就不能进行格式化，而是返回存储器复位状

态。这种情况是在 CPU 的 STOP 灯慢速闪烁时使用，是一种被动的格式化，在正常使用的情况下

无法用 MRES 格式化 MMC 卡。 

2.1.6.  关于 MMC 卡的其它信息 

1. 关于 MMC 其他问题请参考文档“MMC 的信息及使用”。如 MMC 卡的升级，以及插入

MMC 卡时 PLC 所有灯闪烁等问题。 

该文档下载地址：http://www.ad.siemens.com.cn/service/e-training/detail.asp?attachmentid=178
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2.2. 标准型 S7-300 CPU 

标准型 S7-300 CPU 指的是不使用 MMC 卡的 S7-300 PLC，也称为老式的 S7- 300 CPU。

除了 CPU318- 2DP 外，其它的老式 CPU 已不再出售。标准型 S7-300 含有内置的 RAM 装载

存储器，并可以使用 FEPROM 卡来扩充装载存储器。另外，只有 CPU 318-2DP 可以使用 RAM

卡来扩充装载存储器。 

2.2.1. 用于标准型 S7-300 CPU 的 FEPROM 卡 

标准型的 S7-300CPU 有内置的 Load memory ，通过插入 FEPROM(Flash FEPROM)卡扩展装

载存储器，Flash FEPROM 卡更重要的是作为程序备份。在没有后备电池时 PLC 掉电，在 PLC

上电后都会自动从 FEPROM 卡中拷贝程序到 CPU 的工作存储器中。CPU318 的存储区与

S7-400CPU 类似，工作存储器分为存储数据和存储程序两部分，分别存储指令代码和数据块。

过程如图 8－4 所示： 

 

Flash EPROM存储器卡中块的读出和写入

内部装载存储器
RAM

“装入”

装载
Flash EPROM

“装入 EPROM”

工作存储器
RAM

插入存储器
卡后：
申请存储器
复位并拷贝
到工作存储
器

可执行
的部分

“装到 PG”

                                   图 8－4 
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用于标准型 S7-300 CPU 的 Flash EPROM 卡(FEPROM 卡)型号如下： 

16 KB   6ES7 951-0KD00-0AA0 

32 KB   6ES7 951-0KE00-0AA0 

64 KB   6ES7 951-0KF00-0AA0 

128 KB  6ES7 951-0KG00-0AA0 

256 KB  6ES7 951-1KH00-0AA0 

512 KB  6ES7 951-0KJ00-0AA0 

1 MB    6ES7 951-1KK00-0AA0 

2 MB    6ES7 951-1KL00-0AA0 

4 MB    6ES7 951-1KM00-0AA0 

 

注：以上产品的订货号会因为产品软硬件的升级略有调整，产品特性以产品名称为准。 

2.2.2. 只用于 CPU 318-2DP 的 RAM 卡 

128 KB  6ES7 951-0AG00-0AA0 

256 KB  6ES7 951-1AH00-0AA0 

512 KB  6ES7 951-1AJ00-0AA0 

1 MB    6ES7 951-1AK00-0AA0 

2 MB    6ES7 951-1AL00-0AA0 

注：以上产品的订货号会因为产品软硬件的升级略有调整，产品特性以产品名称为准。 

2.2.3. 如何将程序写入 FEPROM 卡 

1. 在 STEP 中使用“PLC>Download User Program to Memory Card”菜单命令（如图 8－2）。

此时用户程序只能是整体写入 FEPROM 卡，而不能写入单个或部分程序块，同时，每次写入

新的程序会清除原来存在卡中的程序，同时会清除内置 RAM 区的内容。  

2. 在 STEP 中使用 “Copy RAM to ROM”指令（如图 8－2），可以把工作存储器的内容拷贝

到 FEPROM 卡中，同时会将 FEPROM 卡中原来的内容清除。这个指令用于保存 PLC 的当前

运行值拷贝到 PLC 中，这样下次用 MRES 复位时，DB 块的值就会复位为保存过的值。此方

法也同样适用于 MMC 卡。 

3. 使用 PG 时可以在 STEP 中使用“File > S7-Memory Card > Open”打开存储卡再用      
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“PLC > Save to Memory Card ”将数据写入 FEPROM.此操作对于 MMC 卡同样有效。此方法

也同样适用于 MMC 卡。 

2.2.4. 如何删除 FEPROM 卡中的程序 

目前，删除 FEPROM 卡中的程序的公开方法只有一种，就是用 PG 和读卡器来删除卡中的内容，

使用存储器复位是无法清空卡里的程序的。 

但下述方法同样可以删除 FEPROM 卡中的内容： 

1. 在 STEP 中使用“Download user program to memory card ”命令可以把程序直接下载到

FEPROM 中，每次用这个命令下载时，都会清除 FEPROM 卡中以前下载的程序。当下载

的程序大于工作存储器或者大于 FEPROM 卡的容量时使用“Download user program to 

memory card”命令时会出现报警信息，下载过程仍然可以继续，但是下载完成后会出现错

误信息，PLC 故障灯亮，此时从 CPU 的模板信息“Module information”中可以看到 FEPROM

卡中内容为空，相当于删除了卡里的东西，之后可以重新在卡里下载新的程序。 

2. 在 STEP 中使用“Download user program to memory card”下载一个空的程序到卡中，即

可清空卡中的内容。 

3. 通过在线删除工作存储器中的全部程序，再在 STEP 中执行“Copy RAM to ROM”命令可

以将 FEPROM 卡中的内容全部删除。对于含有内置的 EPROM 的 CPU 时，也可就用此方

法来删除 EPROM 中的内容。（仅适用于标准型 S7-300 PLC） 

4. 当 CPU 的设置读写保护后，直接用下载的快捷键则下载到内置的 RAM(load memory)中，

此时加密信息可以通过复位删除或执行“Download user program to memory card”下载一

个空的程序到卡中，此时可清除 CPU 中的密码。若 CPU 的设置读写保护后，执行“Download 

user program to memory card”下载加密程序到 FEPROM 卡，则无法清除该密码。 

5. 使用读卡器或 PG 来删除。当在卡中加密又丢失了密码的情况只能用这种方法来删除卡中

的内容。 

2.2.5. 关于 FEPROM 卡的其它信息 

   对于标准型 S7-300CPU,每次拔卡后上电或者插卡后上电，CPU 都会要求执行复位，Stop 灯出现

慢闪，需要用 MRES 复位（用 MRES 复位注意：拔卡和插卡均只可在掉电时进行）。对于 S7-400CPU

每次拔卡后上电或者插卡后上电 CPU 都不会要求执行复位，但在拔卡后，工作存储器的程序自动丢

失，即使有后备电池也一样。 
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2.3. 带内置 EPROM 的 S7-300 CPU 

     对带有集成 EPROM 的 CPU 模块，可以使用“Copy RAM to ROM”将程序复制到集成 EPROM

中，以确保在没有备用电池的情况下发生电源故障或存储器复位时数据不丢失。 CPU 312 

IFM、 CPU 314 IFM 和 C7 系列 带有内置的 EPROM 装载存储器，由于不太常用，这里不作

重点描述。 

3. 关于数据保持 

3.1. CPU 启动方式： 

S7-300CPU 只有“暖启动”(Warm Start),但 CPU 318-2 DP 的启动方式可定义为暖启动(Warm 

Start)和冷启动(Cold Start)两种，定义为暖启动时与其他标准型 S7-300 相同，定义为冷启动时，与

S7 400 的冷启动相同)。暖启动调用 OB100 组织块。当启动时，过程映像和非保持数据被清除。

当过程映像读入后，就开始新的一个循环。 

 

                       图 9－1 

 

 

CPU 属性：启动
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在 S7-300CPU 中，“PowerOn->PowerOff”或从”STOP-> RUN”两种情况下都执行“暖启动”

（Warm Restart）。 

1. 对于使用 FEPROM 卡的标准型 S7300 CPU： 

1)  带后备电池的暖启动： 

      当暖启动时，后备电池保持的 RAM 存储器 (OB, FC,FB, DB) 和位存储器(M)、定时器(T)

和计数器(C)都被保持。只复位不保持的位存储器(M)、定时器(T)和计数器(C)。过程映像和

非保持数据被清除。 

2) 不带后备电池的暖启动: 

    如果 RAM 存储器没有电池作后备，就会丢失所存的信息。只有定义成保持的位存储器(M)、

定时器(T)和计数器(C)和数据块（DB）的数据可以被保持。 

  

   

图 9－2 

 

“保持存储器”(Retentive Memory)标签页用来指定需要保持的位存储器(M)、定时器(T)、计

数器(C)和数据块（DB）区域。(如图 9－2) 

 

CPU 属性：保持

仅当如果CPU 没有
后备电池时有效
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2. 对于使用 MMC 卡的新型 S7300 CPU 

暖启动时，所有的数据块（DB）都是被保持的，“保持存储器”(Retentive Memory)标签页的

定义区为“灰色”不可选的，如图 9－3 所示。定义了保持的存储器（M）、定时器(T)、计数器

（C）中的数据将被保持。过程映像和非保持数据被清除。 

 

                                  图 9－3 

3.2. S7-300 CPU 存储器复位 

当存储器复位时，工作存储器、内置装载存储器（对于标准 CPU）和带保持的数据都被

清除，然后执行硬件测试。如果存储器卡存在，用户程序就从存储器卡拷贝到工作存储器。 

存储器复位具体完成工作如下： 

  删除工作存储器所有的用户数据,包括保持的数据 (不包括 MPI 参数分配) 

  硬件测试和初始化 

  对于使用 EPROM 卡的 CPU,如果插入了 EPROM 存储器卡，且卡中存有用户程序，  

在存储器复位后 CPU 把 EPROM 的内容拷贝到内部工作存储区。 

对于使用 MMC 卡的 CPU ，在存储器复位后 CPU 把 MMC 卡的内容拷贝到内部 工

作存储区。 

 如果没有插入存储器卡，设定的 MPI 地址保持。但是，如果插入存储器卡， 则装

入卡内的 MPI 地址 

 诊断缓冲区的内容保持，该区的内容利用编程器可以观察到。 
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注意：必须在 CPU 是停止模式时才能执行存储器复位： 

 模式选择器位于“STOP”位置或 

 模式选择器位于“RUN-P”位置，通过菜单操作“PLC -> Operating Mode -> Stop”

用把模式切换到 STOP。 

3.3. 新型 S7-300 CPU(使用 MMC 卡)的数据保持问题 

1． 存储器（M）、定时器(T)、计数器（C）的可保持性取决于是否被组态为保持，如果组

态为非保持，则Stop->Run或者Power off/on均被复位，如果组态为保持，则Stop->Run

或者 Power Off/On 均被保持。 

2． DB 始终保持，不管 Stop->Run 或者 Power off/on.但下述过程会复位 DB 块的值： 

掉电-〉拔卡-〉上电-〉掉电-〉插卡-〉上电 

存储器对象的记忆 

             操作状态变换 
存储器对象 

通电/断电 STOP->Run 存储器复位

用户程序/数据（MMC中） X X X 

数据块的实际值 X X - 

保持的存储器（M）、定时器(T)、计数器（C） X X - 

诊断缓冲区、运行小时计数器 X X X 

MPI 地址、传输速率 
X X X 

X=保持    －＝非保持 

3.4. 标准型 S7-300 CPU（除了 CPU 318-2 DP）的数据保持问题： 

1． 存储器（M）、定时器(T)、计数器（C）  

存储器（M）、定时器(T)、计数器（C）的可保持性取决于是否被组态为保持，如果定义为

非保持，则 Stop->Run 或者 Power off/on 均被复位，如果被组态为保持，则 Stop->Run 或者 Power 

off/on 均被保持，不管有无电池。但注意，无电池时，必须要有 FEPROM 程序备份，否则，组

态丢失。 
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2． 数据块 DB 

Stop->Run：所有 DB 保持，不管是否设为保持 

Power Off： 有电池时，所有 DB 保持，不管是否设为保持 

 无电池有卡时： 

 当 DB 块被定义为非保持，则复位 

 当 DB 块被定义为保持，则数据保持 

 

存储器对象的记忆 

             操作状态变换 
存储器对象 

通电/断电 STOP->Run 存储器复位 

用户程序/数据（FEPROM卡） X X X 

数据块（CPU带电池，且设为保持） X X X 

数据块（CPU不带电池有卡，设为保持） X X - 

数据块（CPU不带电池有卡，未设为保持） - X - 

保持的存储器（M）、定时器(T)、计数器（C） X X - 

诊断缓冲区、运行小时计数器 X X X 

MPI 地址、传输速率 X X X 

X=保持    －＝非保持 
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4. 缩写词含义 

IEC：International Electrotechnical Commission，国际电工技术委员会。 

FAQ：Frequently Asked Questions，常见问题解答。 

RAM：Random Access Memory ，随机存取存储器。 

它的特点是易挥发性，即掉电失忆。ＲＡＭ是动态内存,用来存取各种动态的输入输出数据、

中间计算结果以及与外部存储器交换的数据和暂存数据。设备断电后，ＲＡＭ中存储的数据

就会丢失。ＲＡＭ就好比是电脑的内存,运行游戏、程序速度快慢看的是ＲＡＭ。 

ROM：Read Only Memory 只读存储器(一次写入，反复读取)。 

RAM 和 ROM 相比，两者的最大区别是 RAM 在断电以后保存在上面的数据会自动消失，而

ROM 就不会。ROM 又分一次性固化、光擦除和电擦除重写两种类型。ＲＯＭ是静态空间，

用来存储东西的，如计算机中主板中的 BIOS 就是采用的 ROM。 

PROM：Programmable Read-Only Memory,可编程只读存储器。 

只允许写入一次,所以也被称为“一次可编程只读存储器”(One Time Progarmming ROM，

OTP-ROM)。 

EPROM：Erasable Programmable ROM，可擦除可编程只读存储器。 

可重复擦除和写入，使用紫外线照射一定的时间可擦除其内容，擦除后即可进行再编程。 

EEPROM : Electrically Erasable Programmable ROM，电可擦除可编程只读存储器 

它的最大优点是可直接用电信号擦除，也可用电信号写入。 

FEPROM： Flash  EPROM ,闪存可擦除可编程只读存储器。 

它属于 EEPROM 的改进产品，由于闪存卡可以在体积上做得很小，所以闪存卡在手机、数码相

机、掌上电脑、MP3 等设备上获得了广泛的应用。如目前比较流行 CF 卡（Compact Flash）、

SD 卡（Secure Digital Memory Card）、索尼的记忆棒（Memory Stick）等。 

MMC：  Micro Memory Card ， 微型存储卡。 

它是一种 FEPROM 卡，主要用于西门子新型 S7-300CPU 及紧凑型 S7-300CPU 中(如 CPU31xC)。 

市场中的用于手机的通用型 MMC 卡不能用于西门子的 CPU 中，必须使用西门子专用的 MMC 卡。 

PG：Programming device，西门子编程器。 

西门子出品的预装西门子工程软件（如 STEP7,Wincc 等），集成 CP5611 接口, 具备读写 MMC 和

EPROM 卡接口的便携式 PC 机。 
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5. 附录-相关设备订货号 

5.1. 存储卡 

 用于新型 S7-300 CPU 的 MMC (Micro Memory Card ) 

MMC 卡已经分配了新的订货号 

     名   称 新订货号 旧订货号 

64 KB 微存储卡 6ES7953-8LF20-0AA0 6ES7953-8LF11-0AA0 

512 KB 微存储卡 6ES7953-8LJ20-0AA0 6ES7953-8LJ11-0AA0 

2 MB 微存储卡 6ES7953-8LL20-0AA0 6ES7953-8LL11-0AA0 

4 MB 微存储卡 6ES7953-8LM20-0AA0 6ES7953-8LM11-0AA0 

128KB 微存储卡  *** 6ES7 953-8LG11-0AA0 

*注意事项： 

128 KB 的 MMC 卡尚未分配新的订货号；当前的订货号暂时仍然有效（6ES7953-8LG11-0AA0)。  

兼容性： 

     新的 MMC 卡与先前版本的 MMC 卡在功能和备件上是兼容的。 

 用于标准型 S7-300 CPU 的 FEPROM 卡 

16 KB   6ES7 951-0KD00-0AA0 

32 KB   6ES7 951-0KE00-0AA0 

64 KB   6ES7 951-0KF00-0AA0 

128 KB  6ES7 951-0KG00-0AA0 

256 KB  6ES7 951-1KH00-0AA0 

512 KB  6ES7 951-0KJ00-0AA0 

1 MB    6ES7 951-1KK00-0AA0 

2 MB    6ES7 951-1KL00-0AA0 

4 MB    6ES7 951-1KM00-0AA0 

 

 用于 S7-400 CPU 的 FEPROM 卡 

64 KB   6ES7 952-0KF00-0AA0 

256 KB  6ES7 952-0KH00-0AA0 
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1 MB    6ES7 952-1KK00-0AA0 

2 MB    6ES7 952-1KL00-0AA0 

4 MB    6ES7 952-1KM00-0AA0 

8 MB    6ES7 952-1KP00-0AA0 

16 MB   6ES7 952-1KS00-0AA0 

32 MB   6ES7 952-1KT00-0AA0 

64 MB   6ES7 952-1KY00-0AA0 

 只用于 S7 318-2DP 的 RAM 卡. 

128 KB  6ES7 951-0AG00-0AA0 

256 KB  6ES7 951-1AH00-0AA0 

512 KB  6ES7 951-1AJ00-0AA0 

1 MB    6ES7 951-1AK00-0AA0 

2 MB    6ES7 951-1AL00-0AA0 

 用于 S7 400 CPU 的 RAM 卡 

64 KB   6ES7 952-0AF00-0AA0 

256 KB  6ES7 952-1AH00-0AA0 

1 MB    6ES7 952-1AK00-0AA0 

2 MB    6ES7 952-1AL00-0AA0 

4 MB    6ES7 952-1AM00-0AA0 

8 MB    6ES7 952-1AP00-0AA0 

16 MB   6ES7 952-1AS00-0AA0 

 用于扩展 S7 417-4 CPU 的工作存储器的 RAM 卡 

2*2M   6ES7 955-2AL00-0AA0 

2*4M   6ES7 955-2AM00-0AA0 
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5.2. USB 读卡器 

     使用 USB 读卡器可以格式化所有 FEPROM 存储卡以及 MMC 卡 

 

Product Designation  Order No.  

USB Prommer  6ES7 792-0AA00-0XA0  
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6. 附录－推荐网址 

6.1. 西门子自动化与驱动产品的在线技术支持 

首先我们建议您访问西门子（中国）有限公司自动化与驱动集团客户服务与支持中心技术支持网

站：http://www.ad.siemens.com.cn/service/您可以在检索窗口中键入STEP7，MMC或 Compatibility等

关键字，获取相关信息； 或通过点击以下链接或取更多信息。 

专家推荐精品文档：http://www.ad.siemens.com.cn/Service/recommend.asp

AS常问问题：http://support.automation.siemens.com/CN/view/zh/10805055/133000  

AS更新信息：http://support.automation.siemens.com/CN/view/zh/10805055/133400  

“找答案”AS版区：http://www.ad.siemens.com.cn/service/answer/category.asp?cid=1027

网上课堂：http://www.ad.siemens.com.cn/service/e-training/下载相关资料。 

 

                                图 1 

6.2.  西门子自动化产品的其它网站 

http://www.ad.siemens.com.cn/products/as/s7_200/ 提供S7-200 PLC相关知识及软件下载。 

https://mall.automation.siemens.com/CN/guest/查找西门子自动化与驱动的所有产品订货号、图片、

及技术参数,或在技术支持与服务网站http://www.ad.siemens.com.cn/service/通过点击“A&D Mall” 

进入该网站进行查询（如图 1）。 
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6.3. 需设备选型及订货 

如需设备选型及订货，请联系西门子公司销售当地西门子分销商。分销商联系方式可致电

400-810-4288 听到提示音后选则按键 3，进行信息咨询。 

6.4. 西门子技术支持热线 

     如有无法自行解决的技术问题，请拨打西门子技术支持热线 400-810-4288 进行问题登记或

在我们的技术支持与服务网站http://www.ad.siemens.com.cn/service/点击“技术问题提交”进行问

题登记（如图 1），等待西门子技术支持工程师回复。我们会在周一至周五 8:15 至 17:15 工作时

间内对您的技术问题进行解答。请注意在登记问题时尽量准确地描述所使用产品的类型，以便

尽快得到负责该产品的工程师的帮助。 

技术支持传真：010-64719991。 

技术支持邮箱：4008104288.cn@siemens.com。 

A&D Service & Support Page 23-24 

                                   
 

http://www.ad.siemens.com.cn/service/
mailto:adscs.china@siemens.com

	S7 300存储区概述
	S7-300 CPU的分类
	新型S7-300 CPU
	用于新型S7-300 CPU的MMC卡
	MMC卡使用寿命
	如何将程序写入MMC
	如何删除MMC卡中的程序
	删除MMC卡中的程序的特殊情况：被动格式化
	关于MMC 卡的其它信息

	标准型S7-300 CPU
	用于标准型S7-300 CPU的FEPROM卡
	只用于CPU 318-2DP 的RAM卡
	如何将程序写入FEPROM卡
	如何删除FEPROM卡中的程序
	关于FEPROM卡的其它信息

	带内置EPROM 的S7-300 CPU

	关于数据保持
	CPU启动方式：
	S7-300 CPU 存储器复位
	新型S7-300 CPU(使用 MMC卡)的数据保持问题
	标准型S7-300 CPU（除了CPU 318-2 DP）的数据保持问题：

	缩写词含义
	附录-相关设备订货号
	存储卡
	USB读卡器

	附录－推荐网址
	西门子自动化与驱动产品的在线技术支持
	西门子自动化产品的其它网站
	需设备选型及订货
	西门子技术支持热线


